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Preface

Purpose

The Attorney’s User Guide provides instructions on how to use the Case Management
Electronic Case Files (CM/ECF) system to file documents with the court. This guide also
provides enough information to use PACER to view and retrieve docket sheets and
documents. If more information is needed for PACER than what is provided in this guide,
then go to the following website and review the resources provided there:

http://www.pacer.gov

Audience

The CM/ECF Attorney’s User Guide is intended for attorneys and users that file documents
electronically to the United States Bankruptcy Court for the Southern District of Texas. This
information may not be accurate for other districts.

Notations

The following notations are used throughout this guide:

Notation Description
@ This image indicates a warning message. The text that follows is in red. The
v/ message identifies activities that will or could cause the application to not func-

tion as expected or required.

a This image indicates that important information is being provided that the
L reader should be aware of when using the application. The application will con-
tinue to function properly whether the information provided is used or not.

The light bulb indicates a tip or trick is being provided on how to use the appli-
Q cation to its full potential.

plain text The base font for the manual is Palatino Linotype size 11.

bolded text Dialog names are bolded.



http://www.pacer.gov/
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Notation Description

blue text Cross references to another topic in the manual are bolded and blue. Click the
bolded, blue text to move to the cross-referenced information.

green text Image call outs are bolded and dark green in a smaller size of the base font.

text Menu items, button names, and the dialog’s field/option names are in the Times
New Roman font, size 11, bolded, and italicized.

text » text Menu selection involving submenus use the » symbol. For example to select
Print from the File menu, the manual will use File » Print.

value When a value or command must be enter from the keyboard, the information is
command in the Arial font, size 10 and bolded.

value repvalue | When the value/command contains a component that must be replaced with a
value pertinent to your situation, that replacement is italicized. Afterwards, an
explanation will be given like the following:

Where repvalue is replace with __ for your court.

directory path When a directory path or directory path and filename are provided, the informa-
tion is in the Arial font, size 10.

filename When a filename is provided without a directory path, the filename is in the
Arial font, size 10 and bolded.
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Chapter 1
| ntroduction to CM/ECF

Purpose This chapter provides information that an attorney needs before getting started
using CM/ECE, including where to get help, definition of terms, system
requirements, and other CM/ECF and PACER capabilities and registration
information.

Chapter Topics The following topics are covered in this chapter:
* QOuverview, page1-2
* Help Desk, page 1 -2
* Definitions, page 1 -2
e Systems Requirements, page 1 —4
* CM/ECF System Capabilities, page 1 -5

* PACER Registration, page1-5
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Overview

Overview

This guide provides instructions on how to use the Case Management Electronic Case Files
(CM/ECEF) system to file documents with the court, or to view and retrieve docket sheets and
documents. The screen shots that display may differ slightly as you electronically file your
documents, due to enhancements or upgrades.

All users should have a working knowledge of Microsoft® Internet Explorer® and Adobe®
Acrobat®. For questions regarding these applications, please refer to their user manuals.

Before electronically filing, you should be thoroughly familiar with the following documents:

* Administrative Procedures for the Filing, Signing, and Verifying of Documents by Electronic
Means in Texas Bankruptcy Courts

http://www.txs.uscourts.gov/attorneys/cmecf/bankruptcy/adminproc.pdf

e Local Rules

http://www.txs.uscourts.gov/bankruptcy/rulesformsproc/localrules/default.htm

Help Desk

For questions regarding this guide, CM/ECE, or filing pleadings/documents, you can contact
the CM/ECF Help Desk at bankruptcy ecf helpdesk@txs.uscourts.gov or by phone at (866)
358-6201. Support hours are Monday through Friday 8:00 a.m. to 5:00 p.m. CST. When
sending email, include the case number.

Definitions

The following definitions are used throughout this guide:

Court For purposes of this guide, court is the United States District and
Bankruptcy Court for the Southern District of Texas.

Electronic Filing The uploading of a pleading or document, in PDF format, directly
from the registered user’s computer, using the Court’s Internet-based
system to file that pleading or document in the Court’s case file. Send-
ing a document or pleading to the Court via e-mail as an attachment
does not constitute “electronic filing.”


mailto:bankruptcy_ecf_helpdesk@txs.uscourts.gov
http://www.txs.uscourts.gov/attorneys/cmecf/bankruptcy/adminproc.pdf
http://www.txs.uscourts.gov/bankruptcy/rulesformsproc/localrules/default.htm
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Electronic Filing
System

Filing User

Hyperlink

Notice of Electronic
Filing (NEF)

PACER

Portable Document
Format (PDF)

The Court’s automated system that receives and stores documents
which were filed in electronic form. The program is part of CM/ECEF,
which was developed for the Federal Judiciary by the Administrative
Office of the United States Courts.

A person registered to file documents electronically with the Court.
Filing users must be one of the following:

¢ Admitted to practice before the United States Bankruptcy
Court for the Southern District of Texas and a member in good
standing of the Court.

¢ Admitted pro hac vice.
¢ Authorized to represent the United States of America.
OR

¢ Proceeding as a nonprisoner pro se litigant approved as a filing
user by the Court.

A filing user must receive a login and password from the Bankruptcy
Court to use the Court’s electronic filing system.

A reference in a hypertext document that refers to another document
or other resource. It is similar to a citation in literature. However,
combined with a data network and suitable access protocol, it can be
used to retrieve the resource referenced. A hyperlink document can
be saved, viewed, or displayed as part of the referencing document.

An electronic notice that is automatically generated by the electronic
filing system at the time a document is docketed. The NEF includes
the time of filing and docketing, the name of the party and filing user
filing the document, the type of document, the text of the docket
entry, the name of the party, and filing user receiving the notice. If a
document is attached to the docket entry, the NEF contains a hyper-
link to the filed document allowing recipients to retrieve the docu-
ment.

Public Access to Court Electronic Records (PACER) is an automated
system allowing a user to view, print, and download Court docket
information over the Internet. Users must register with the PACER
Service Center at http://pacer.psc.uscourts.gov/.

A document file that was either created with a word processor or was
originally a paper document scanned and converted to a PDF file.
Documents must be converted into PDF format to be filed electroni-
cally with the Court. These files have the file extension .pdf.



http://pacer.psc.uscourts.gov/
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Pro Se Litigant

Scanned
Documents

Traditional Filing/
Traditionally Filed

A person who represents oneself in a Court proceeding without the
assistance of an attorney.

These are the paper documents that are converted to PDF via a
scanner or multifunction copier or scanner, as opposed to converting
an electronic document from a word processor. When scanning paper
documents that will subsequently be filed electronically, filing users
should configure their scanners for 300 dpi and black and white
scanning (rather than color scanning).

This is also referred to as “conventional filing,” which is submitting
paper copies of pleadings and documents in the traditional or
conventional manner either in person, by courier, or via United States
Postal Service.

Systems Requirements

The hardware and software required to electronically file, view, and retrieve case documents

are the following;:

* A computer running a standard platform such as Microsoft Windows® or a
Macintosh® operating system.

* Adobe Acrobat or other software capable of converting documents from a word
processor format to the portable document format (PDF)

¢ A PDF-compatible word processor like Macintosh or Windows based versions of
Microsoft Word and Corel® WordPerfect®.

¢ A compatible Internet browser.

* Access to a scanner if non-computerized documents need to be imaged.

A

A scanner should only be used for documents that cannot be produced
electronically. Scanned documents may diminish the quality of service we

provide by slowing down the entire system. We are moving away from the
utilization of scanned documents inside the Court and are asking you to do the
same when possible.
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CM/ECF System Capabilities

The electronic filing system allows registered participants with Internet accounts and
Internet Explorer software to perform the following functions:

¢ Open the Court’s web page.

* View or download the most recent version of the User Guide.

* Electronically file pleadings and documents in actual (live) cases.
¢ Self-train on the PACER web-based tutorial.

* View official docket sheets and documents associated with cases.

¢ View various reports (e.g., Cases Filed Report, Calendar) for cases that were filed
electronically.

PACER Registration

CM/ECEF users must have a PACER account with the Court in order to use the Query and
Report features of the CM/ECF system. If you do not have a PACER login, contact the PACER
Service Center to establish an account. You may call the PACER Service Center at (800) 676-
6856 for information or to register for an account. Also, you may register for PACER online at
http://pacer.psc.uscourts.gov/register.html. A link to PACER's site is provided on the Court’s
website.



http://pacer.psc.uscourts.gov/register.html
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Chapter 2
Wor king with PDF Files

Purpose This chapter provides information on the PDF file format, including how to view
them and convert Microsoft Word and WordPerfect files to this format.

Chapter Topics The following topics are covered in this chapter:
o Setting Up Adobe Acrobat, page 2 -2
* Portable Document Format (PDF), page 2 -2
* How to View PDF Files, page 2 -2
* How to Convert Documents to the PDF Format, page 2 — 4
* CM/ECF Limitation on PDF Document Size, page 2 - 5
* Common Mistakes When Filing PDF Documents, page 2 -5
* Email Notification of Filed PDF Documents, page 2 — 6

* Certificate of Service, page 2 — 6
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Setting Up Adobe Acrobat

Users must set up Adobe’s Acrobat Reader® or Adobe Acrobat Professional in order to view
documents that have been electronically filed on the system. All pleadings must be filed in
PDF format. When installing these products, please review and follow Adobe’s directions to
use the product effectively.

Portable Document Format (PDF)

Only PDF documents may be filed with the Court using the CM/ECF system. Before sending
the file to the Court, users should preview the PDF formatted document to ensure that it
displays in its entirety and in the proper format. The PDF document should not include any
embedded files like scripts, files, and executables. Filings with these embedded attachments
will be rejected by CM/ECE. For information on PDF size limitations in CM/ECF, see page 2 -
5.

How to View PDF Files

All PDF files can be viewed in Adobe Acrobat Reader or Adobe Acrobat Professional. There
are two access methods upon which you can view the files.

Directly Selecting PDF Files

The fastest method for viewing a PDF file is to select the file in Explorer. When the Adobe
Acrobat software was installed, a file association to the PDF file format should have
automatically been set. This association allows you to double-click the PDF file to open it

directly in Acrobat.
If the file association does not work: Open with Acrobat 9
Print
1 . nght-Clle any PDF flle % Combine supported files in Acrobat...

Scan for Viruses...

2. Select Open with » Choose default program.  Nfevel Copy...
Open with d .\~ Adobe Acrobat 9.4
Restore previous versions @Intemet Explorer

y EaWordPerfect X5

Send to

Choose default program...

Cut
Copy

Create shortout
Delete
Renarme
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The Open with dialog displays.

openwith x|
—.1 Choose the program you want to use to open this file:
]
File:  Attorneys_User_Guide.pdf
Recommended Programs =
Adobe Acrobat 9.4 F Internet Explorer
B~ dobe Systems Incorporated ( Microsoft Corporation
WordPerfect X5
Corel Corporation
Other Programs =
Adobe Dreamweaver C55 Adobe FrameMaker 10
Adobe Systems, Inc, Adobe Systems Incorporated.
5/I Microsoft Office 2010 Microsoft Visual Studio Version Selector
] 1 crosoft Corporation w Microsoft Corporation
/w. Microsoft Word 7] Notepad
Microsoft Corporation & B Microsoft Corporation LI
¥ Always use the selected program to open this kind of file Browse. .. |
If the program you want is not in the list or on your computer, you can look for the appropriate program on the
Web,
OK I Cancel |

3. Select the Adobe Acrobat program.

4. Check the box Always use the selected program to open thiskind of file.

5. Click OK.

The file association is now set for all future selections.

Selecting PDF Fileswithin Adobe Acrobat
To select the PDF within Adobe Acrobat:
1. Open Adobe Acrobat Reader or Adobe Acrobat Professional.
2. Select File» Open.
The Windows Open dialog displays.
3. Navigate to and select the desired PDF file.
4. Click Open.

The PDF file now displays in Adobe Acrobat.
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Viewing Options
Once the PDF displays, there are several viewing options available depending on your
version of Adobe Acrobat Reader or Adobe Acrobat Professional. To learn more about the
viewing options available to you:
e Select the View menu and review the items it contains.

¢ Hover your cursor over the toolbar for a description of each toolbar icon.

¢ Select Help » Adobe Acrobat and review the online help topic Workspace » Viewing PDF
pages.

How to Convert Documentsto the PDF For mat

You must convert your documents to PDF format before submitting them to the Court’s CM/
ECF system. Both Microsoft Word and WordPerfect create text searchable PDF files as

follows:

1' Open the dOCU— @ | Documentl - Microsoft Word o B ER
ment mn Word or Home Insert Page Layout References Mailings Review View e
WordPerfect.

5
e sere Print
. B Save As
2. SeleCt F||e tab ~ @ Copies: 1 -
=~ Open .
and then the - print
. | Close
Print item. =
Info Printer
e / Adobe PDF .
The printing R ) nrey
WlndOW N Printer Properties
. ew
displays. Settings
3. For WOI’d'S S ST 4 Print the entire document
printer or Pages:
WordPerfect’s Help J Print One Sided =
destination 2 options Only print on one side of th...
Collated
name, select B3 et BB, 2 05 123 T
Adobe PDF.
j Portrait Orientation -
Letter .
85"x11
MNormal Margins .
t— Left: 1" Right: 1"
J 1 Page Per Sheet -
f
Page Setup 1 f 0% (= o=
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4. Click the Home tab to return to the document.
The document automatically adjusts to the Adobe PDF print driver settings.

5. Scroll through the document, to verify or change the formatting and location of
section headings.

6. Select Filetab and then the Print item.
The printing window displays again.
7. Click the Print button.
The Save PDF File As window displays.
8. Navigate to the folder where the PDF file should be saved.
9. Enter a file name and click Save.

A text searchable PDF file is created.

CM/ECF Limitation on PDF Document Size

The current size limitation that CM/ECF allows for electronically filed documents, including
exhibits or attachments, is 5 megabytes. While this limit will not likely affect electronically
created documents, in the case of imaged documents, it would be the equivalent of
approximately 75 pages.

It is the responsibility of the filing user to ensure that PDF files meet the file size restrictions.
Larger electronic documents must be divided into smaller PDF files. For example, an eight
megabyte PDF file could be divided into one 5 megabyte and one 3 megabyte file.

Common Mistakes When Filing PDF Documents

Some common mistakes made when filing PDF documents include:
¢ Selecting the wrong PDF file to attach to a docket entry.

¢ Selecting the wrong document type (i.e., the original document rather than the
converted file with the .pdf extension).
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¢ Selecting the wrong docketing event from the CM/ECF menus.

* Entering the wrong case number and not discovering the error before completing the
transaction.

The CM/ECF system does not permit you, or the clerk’s office, to substitute or remove a
misfiled PDF document after it has been submitted and electronically delivered to the court.
Only the presiding judge may order the unfiling of a document once it has been filed. So, be
careful to avoid these common mistakes.

If a mistake has been made, contact the CM/ECF Help Desk (see page 1 - 2). When calling,
you must provide the case number and document number(s) for the docket entry or entries
requiring correction.

Email Notification of Filed PDF Documents

After electronically filing a PDF document, the CM/ECF system sends a Notice of Electronic
filing (NEF) to the designated attorneys and parties who have supplied their email addresses
to the Court. The NEF also displays the names and addresses of the individuals who will not
be electronically notified of the filing.

It is the filer's responsibility to serve hard copies of the document and the NEF to

. attorneys and parties who are not set up for electronic notification.

Individuals who receive the NEF are permitted one “free look” at the document by clicking
on the associated hyperlinked document number embedded in the NEF. The filer is
permitted one free look at the document to verify that it was properly docketed. Pursuant to
guidelines set by the Administrative Office of the U. S. Courts, the free look is available only
once within the 15 day grace period from the date of filing.

Subsequent retrieval of the case docket sheet and document from CM/ECF must be made
through your PACER account and is subject to regular PACER fees.

Certificate of Service

A certificate of service must be included with all filed PDF documents reflecting that service
on known filing users will be accomplished through the NEF and indicating the manner of
service on any party who is not a filing user. Refer to Local Rules BK LR 5005-1.
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Chapter 3
Getting Sarted in CM/ECF

Purpose This chapter describes some basic CM/ECF information, including how to log in,
the menu items, what buttons are available for manipulating web pages, and
finally how to verify the correct case number and your CM/ECF transactions.

Chapter Topics The following topics are covered in this chapter:
* Accessing the CM/ECF System, page 3 —2
* The CM/ECF Menu Bar, page 3 -6
* Manipulating Web Pages, page 3 -7
o Verifying Case Number while Docketing, page 3 -7

* Reviewing Your CM/ECF Transactions, page 3 — 8
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Accessing the CM/ECF System

Accessing CM/ECF not only involves logging into CM/ECEF, but for some of its features,
requires users to also log into PACER.

Logging Into CM/ECF

Users can log into the CM/ECF system via the Internet as follows:
1. Enter the following URL address into your browser:

http://www.txs.uscourts.qov/

2. Under Quick Links, click the Bankruptcy Electronic Case Filings (ECF) link.
The Attorney Admissions web page displays.

3. Click the Live Bankruptcy CM/ECF link.
The Live CM/ECF system displays.

4. Click the Southern District of Texas - Document Filing System link.

The ECF Login page displays.

CM/ECF Filer or PACER Login

Notice
[his is a Restricted Web Site for Official Court Business only. Unanthorized entry is prohibited and subject to prosecution under Title 18 of
the US. Code. All activities and access attempts are logged.

nstructions for viewing filed documents and case information:
If vou do not need filing capabilities, enter vour PACER. login and password. If vou do not have a PACER login, you may register online at
hi

JWWW pacer.gov.

nstructions for filing:
Enter your CMUECEF filer login and password if you are electronically filing something with the court.

Authentication IMPORTANT NOTICE OF REDACTION RESPONSIBILITY: All filers must redact:
Login: | Social Security or taxpayer-identification numbers; dates of birth: names of minor children: and
ancial account mumbers, in compliance with Fed R Bankr P. 9037 This requirement applies
Passwaord: I to all documents, including attachments.
Client I
code: " I understand that, if I file, I nmst comply with the redaction rules. I have read this notice.
Clear |
Notice

An access fee of 50.10 per page or 52.40 per document with an andio attachment, as approved by the Judicial Conference of the United
[tates, will be assessed for access to this service. For more information about CM/ECF, click here or contact the PACER Service Center at
800) 676-6856.

CM/ECF has been tested and works correctly with Firefox 3.3, Internet Explover 7 and 8.



http://www.txs.uscourts.gov/
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5. Either:
¢ Enter your CM/ECF login and password if you plan on filing documents.
OR

¢ Enter your PACER login and password if you plan on viewing and querying
information.

ﬂ Login names and passwords are case sensitive.

6. Read the notice boxed in red.
7. Mark the check box within the red boxed-in notice.
8. Click Login to have the login and password validated.

If a valid login and password combination was entered, then the system displays its
main web page (below assumes the CM/ECF information was entered).

EECF Bankruptey ~ Adversary - Reports ~ Utilities ~ Search

U.S. Bankruptcy Court
Southern District of Texas - TRAIN
Official Court Electronic Document Filing System

NOTICE: —
The Bankruptcy Electronic Case Filing System is unavailable from 6:00 a.m. - 6:15 a.m. Monday through Friday, for system maintenance.

Important Notice Regarding Time Period Changes Effective December 1, 2009,
Including 14-Day Deadlines for Filing Schedules, Statements, Chapter 13 Plans, and Bankruptcy Appellate Briefs

Among the time-computation d ts to the Federal Rules of Bankruptcy Procedure that will take effect on December 1, 2009, are changes
to 12 rules that will result in a reduction by one day (from 15 to 14 days) of the time to take action. The affected rules are Bankruptcy Rules
1007, 1019, 1020, 2015, 2015.1, 2016, 3015, 4001, 4002, 6004, 6007, and 8009. Please take note of these changes and particularly of the new 14-
day deadline for filing schedules, statements, and other documents under Rule 1007(c); for filing a chapter 13 plan under Rule 3015(b); and for
filing appellate briefs under Rule 800%(a).
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You can choose any menu item from the blue menu bar along the top of the web

page.

a- The date and time of your last CM/ECF log in appears at the bottom of the web

4 page. You should review this each time you log in. If you suspect your last login
date and time are incorrect, or that an unauthorized party is using your login
and password, contact the court’s Help Desk immediately (page 1 — 2).

If an invalid login and password combination was entered, then the system responds
with the following error message:

Your ECF or PACER login attempt failed. Either vour login name or password is incorrect.

Back |

9. If this occurs, click Back.

The ECF Login page displays again.

10. Return to step 5 and re-enter the login and password.

Logging Into PACER

EECF Bankruptcy ~ Adversary ~ Reports ~ Utilities ~

During your CM/ECF session, if you deviate from either electronically filing a document or
maintaining your user account by selecting the Query or Report menus, the system prompts
you for your PACER login information.

1. Select Query from CM/ECF’s web page.

Search

| v

U.S. Bankruptcy Court
Southern District of Texas - TRAIN
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The PACER Login page displays.

PACER Login

Notice
[This is a Restricted Web Site for Official Court Business only. Unauthorized entry is prohibited and subject to prosecution under Title 18 of the U.S.

Code. All activities and access attempts are logged.

Instructions
Enter your PACER login and password. If vou do not have a PACER login, you may register online at http-//www .pacer. gov. If you have a CM/ECF
filer login and password, and would like to automatically log in to PACER each time you log in as a filer, check the box below.

™ Make this my default PACER. login
JAfter checldng this box, vou will only need to use vour CMUVECF login and password, either for electronic filing or for viewing documents via PACER.

Authentication
Login: ||—
Password: l—
Client code: l—

Clear |

Notice
JAn access fee of 50.10 per page or $52.40 per document with an audio attachment, as approved by the Judicial Conference of the United States, will
be assessed for access to this service. For more information about CM/ECE, click here or contact the PACER Service Center at (800) 676-6856.

ICM/ECF has been tested and woris correctly with Firefox 3.3, Internet Explover 7 and 8.

WARNING: At the bottom of the PACER Login page is a Notice detailing the
= charges for using PACER.

2. Enter your PACER login and password.
3. (optional) Enter a client code.

The Client code field is an optional field which allows PACER functions to be
tracked. It can contain up to 32 characters. If a code is entered, then it is listed on the
billing statement generated by the PACER Service Center; otherwise, it is not on the
statement. Because this code is optional, it must be enforced within a user’s office.

4. (optional) Select Make this my default PACER login check box.
Choosing this check box links your PACER information to your CM/ECF login and

password. This means you will not be required to enter you PACER information
again while working in CM/ECF.

J For information on breaking the link between the CM/ECF and PACER login
. information, see the PACER User Guide.
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5. Click Login to have PACER validate the login and password.

If a valid login and password combination was entered, then CM/ECF continues to
the next web page in the process.

If an invalid combination was entered, then the system responds with the following
error message:

Invalid Your ECF or PACER login attempt failed. Either your login name or password is incorrect.

Back |

6. If this occurs, click Back.

The PACER Login page displays again.

7. Return to step 2 and re-enter the login and password.

The CM/ECF Menu Bar

CM/ECF provides the following menu items in the top blue menu bar of every web page.

E CF Bankruptcy ~  Adversary ~ Query Reports ~  Utilities ~ Search Logout

Menu

Description

Bankruptcy

Files electronically all bankruptcy case motions and other court documents.

Adversary

Files electronically all adversary case motions and other court documents.

Query

Performs queries in CM/ECF by specific case humber, party name, social security
number, or Tax ID type to retrieve documents that are relevant to the case.

Chapter 3 — Getting Started in CM/ECF
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ﬂ You must log into PACER before you can query CM/ECF.

Reports

Retrieves docket sheets, cases-filed reports, claims register, calendar events, etc.

ﬂ You must log into PACER before retrieving these reports.

Utilities

Displays your personal CM/ECF transaction log and allows you to maintain your
CM/ECF account information.

Search

Searches through the CM/ECF menus and events for the specific text you enter.

Logout

Exits CM/ECF and prevents further filing with your password.
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M anipulating Web Pages

The following buttons can be used to manipulate the CM/ECF web pages:

Buttons Description
R Moves the user back one web page. Internet Explorer’s back button is blue, while the
Q Mozilla® Firefox® back button is slightly larger and green. Both are located in the
browser’s upper-left corner. In both cases, you should use them to go back and correct
ﬁi an entry made on a previous web page.
a- If you discover an error after the document is transmitted, contact the
- Help desk.
Clears all characters that have been entered and selections that have been made on
the web page (i.e., it restores the web page back to its starting pointing).

Accepts all input and selections made, and then displays the next

HL CM/ECF web page, if any.

Verifying Case Number while Docketing

As you electronically file, each window displays a case number in the upper left-hand corner.
This ensures that you are docketing to the correct case.

File a Motion:

Case number——pg-30256 Debtor One and Joint Debtor One
Type: bk Chapter: 13 v Office: 4 (Houston)
Assets: y Judge: mi

Case Flag: DEF22c, DEFb7, DEFmaillist, DEFsch, CredCoun

Filename
Browse... |
Attachments to Doc t: & No © Yes

M Clear |

If you are uncertain this is the correct case, right-click on the case number link and select
Open in New Window to run a docket sheet for that case. You will be prompted to enter your
PACER login and password (see page 3 — 4) before viewing the docket sheet. Once you have
verified that this is the correct case, close the new window and return to the previous
window.
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Reviewing Your CM/ECF Transactions

If you need to check what you have done in CM/ECE, select the Utilitiessmenu and then the
View Your Transaction Log link (see page 7 — 4). This feature allows you to review all the
transactions CM/ECF has processed with your login and password.

Besides just reviewing your transactions, you can use the transaction log to confirm if
someone is using your login and password without your permission. If you suspect someone
is using your information, immediately contact the clerk’s office. The clerk’s office will assist
you in changing your password. If you believe that a document has been improperly filed
with the court under your signature (i.e., your login and password is your electronic
signature), you need to take whatever action you deem appropriate.
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Chapter 4
Filing Documents Electronically

Purpose This chapter provides detailed instructions on opening a bankruptcy case and
how to file motions in both bankruptcy and adversary cases.

Filing users should be thoroughly familiar with the document “The Filing, Signing,
and Verifying of Documents by Electronic Means in Texas Bankruptcy Courts” before
filing electronically. You can find this document in the following location:

http://www.txs.uscourts.gov/attorneys/cmecf/bankruptcy/adminproc.pdf

Chapter Topics The following topics are covered in this chapter:
* Opening a Bankruptcy Case, page 4 — 2

¢ Filing a Motion in a Bankruptcy Case, page 4 - 11



http://www.txs.uscourts.gov/attorneys/cmecf/bankruptcy/adminproc.pdf
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Opening a Bankruptcy Case

This procedure describes the process for opening a voluntary bankruptcy case in CM/ECF.

The screen images presented in this section are for informational purposes

o only. Your screen may differ from what you see in this document.

1. Loginto CM/ECF (see page 3 - 2).

The CM/ECF main web page displays.

EECF Bankruptcy ~ Adversary ~ Reports ~ Utilities ~ Search Lngnu‘

U.S. Bankruptcy Court
Southern District of Texas - TRAIN
Official Court Electronic Document Filing System

NOTICE: —
The Bankruptcy Electronic Case Filing System is unavailable from 6:00 a.m. - 6:15 a.m. Monday through Friday, for system maintenance.

Important Notice Regarding Time Period Changes Effective December 1, 2009,
Including 14-Day Deadlines for Filing Schedules, Statements, Chapter 13 Plans, and Bankruptcy Appellate Briefs

Among the time-computation d ts to the Federal Rules of Bankruptcy Procedure that will take effect on December 1, 2009, are changes
to 12 rules that will result in a reduction by one day (from 15 to 14 days) of the time to take action. The affected rules are Bankruptcy Rules
1007, 1019, 1020, 2015, 2015.1, 2016, 3015, 4001, 4002, 6004, 6007, and 8009. Please take note of these changes and particularly of the new 14-
day deadline for filing schedules, statements, and other documents under Rule 1007(c); for filing a chapter 13 plan under Rule 3015(b); and for
filing appellate briefs under Rule 800%(a).

2. Select Bankruptcy from the menu bar.

The Bankruptcy Events page displays.

Bankruptcy Events

AnswerResponse...
Appeal

Claim Actions

Creditor Maintenance...
File Claims
Miscellaneous

Motions/ Applications
Notices

Open Volntary BK Case
Open Involmtary Case
Plan

Judge Trustee Assignment




CM/ECF Attorney’sUser Guide Chapter 4 —Filing Documents Electronically

Opening a Bankruptcy Case

3. Click the Open Voluntary BK Caselink.

The Open Voluntary Bankruptcy Case page displays.

Open Voluntary Bankruptcy Case

Office IHouston 'I

Case type bk
Date filed 10/25/2012

Chapter | 'l

il be filing

e of Designation
lex Chapter 11,

kelect chapter 111

pankruptcy chapter.

Joint Petition (g
Deficiencies |n 'l

M Clear |

4. Select the Chapter number from the drop-down menu.

5. Make the appropriate entries for the Joint Petition and Deficiencies fields.

6. Click Next.

The Search for a debtor subscreen displays.

Open Voluntary Bankruptcy Case

Search for a debtor
SSN/ITIN[ | TaxID/EIN[
Last/Business name I—
First Name I—
Middle Name [
Search |M

7. Enter the SSN/ITIN or Tax ID/EIN information and the last or business name and
click Search.
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If multiple entries are found, a list of names displays. Select the correct name and
click Select name from list. If the name you are looking for is not listed, then click

Create new party.

Search for a debtor

SS]\'IIT]'N' Tax]]]IEE\'l

Last/Business name ||—

First Name I—

Middle Name [
Search |M

Party search results

Smith, Jane Doe, 1111 Main St., Houston, TX
Smith, John

Smith, John E, Houston, TX

Smith, Linda W.. 2546 Milo, Corpus Christi, TX
Smith, Linda W., 2546 Milo, Corpus Christi, TX
smith, john, 806 Main Street, Houston, TX

Select name from list | Create new party |

If no party is found (no names display in the Party search results area), click Create

new party.

Search for a debtor

SSN:’IT[NI Tax]]]fE]'_Nl

Last/Business name l|7

First Name I—

Middle Name [ 1
Search |M

Party search results

No person found.

Create new party |
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Regardless if you click Create new party or Select name from list, the Debtor
Information screen displays.

Debtor Information
Cthlng Select name  FLast name [latten First name |
from list causes i
Mahile l— Generation l— Title l—
CM/ECEF to enter name
data fOI‘ the ltems BSN /ITIN IQQQ- [# The proper format for SSN/ITIN is 999-99-0000 Tax;‘ﬁ—f 11-2222222
boxed in red. These —
) Office | Address 1 |
items cannot be
Change d Address 2 | Address 3 |
City I State | Zip I
County | j Country |
Phone | Fax I
E-mail |
Party text |
Alias... | Corporate parent / affiliate... Review. .. ;;:rznrﬁf:j ?:;Sgsi?iﬁ;ﬁms et alirles
Submit | Cancel | Clear |

8. Update or complete the field entries.

@ If creating a new party and the party has multiple SSN or Tax ID numbers, click
the [+| symbol (which displays after typing within the field) to enter the
additional numbers. You can enter up to 5 SSN and Tax ID numbers.

9. Click Submit.

The following message displays:

Open Voluntary Bankruptcy Case

Divisional Office Houston is chosen

Clear |

10. Click Next to confirm the Divisional Office.
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A subscreen of the Open Voluntary Bankruptcy Case displays requesting additional
information.

Open Voluntary Bankruptcy Case

Prior filing within last 8 years |m vl Type of debtor
- & Individual
F tatus |Paid -
8 stk [P H € Corporation (iaclades LLC & LLP)
Nature of debt I—LI " Partnership
P
Asset notice |N0 'I Eiice
Nature of business
Estimated number of creditors | vl € Health Care Business
Estimated assets | Ll " Single Asset Real Estate
: T " Railroad
Estimated liabilities | j € Stockbroker
" Commodity Broker
" Clearing Bank
" QOther
[ Tax-Exempt Entity

M Clear |

@ The Fee status, Nature of debt, Estimated number of creditors, Estimated
- assets, and Estimated liabilities are required entries.

11. Enter the necessary information, then click Next.

The following notice displays:

Ppen Voluntary Bankruptcy Case

A fter the case is opened, go to Bankruptcy, Judge/Trustee Assignment to assign the judge and, if
applicable, the trustee to this case.

M Clear |

12. Click Next.
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The Summary of Schedules subscreen displays.

Open Voluntary Bankruptcy Case

INEW STATISTICAL REPORTING REQUIREMENTS: YOU ARE NOW REQUIRED TO INPUT TOTALS FROM SCHEDULES
A.B.D.E.F.IJ, CURRENT MONTHLY INCOME FROM FORM 22 AND TOTAL NONDISCHARGEABLE DEBT. THIS
INFORMATION CAN BE FOUND ON OF